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[bookmark: Lesson1]Lesson 1:  Architecture

The first thing to understand about ShelterBase is that it operates using three separate programs:

1. Microsoft SQL Server, the database where the data is actually stored in over 100 tables.  Additionally the database contains hundreds of stored procedures that are used to insert, update, retrieve, and delete records.  Individual user login information is also maintained in the database.
2. ShelterBase Server is installed on the same computer as the database.  The server program takes requests from users, connects to the database to perform the requested operations, retrieves the results, and then returns the results to the user.
3. The ShelterBase client is the program with which the user directly interacts.  The client may be installed on the same computer as the server components or on computers that can connect to the server over a network.

The server components (SQL Server and ShelterBase Server) function as Windows Services, which means they are installed as a core component of the Windows operating system used for the management of long-running processes.  They are set to launch automatically when the operating system loads, requiring no user interaction, and continue to run whether or not a user is logged in.

Because ShelterBase Server is a Windows service, it is necessary to install another program to configure the service operation.  The ShelterBase Configuration Tool is used to start/stop the server, configure it to use the correct SQL Server instance, and set it up for local and network connections to clients.

Finally, while not required, it is highly recommended to install Microsoft SQL Server Management Studio on the server computer.  This program may be used for advanced troubleshooting and data analysis by a user with database knowledge.
[bookmark: Lesson2]
Lesson 2:  Installation

[bookmark: SQLserver]Microsoft SQL Server  

The installation package for the free "Express" version of Microsoft SQL Server can be downloaded from Microsoft in either 32-bit or 64-bit versions (usually the 64 bit version should be selected if the target computer is running a 64 bit version of Windows). 
Once the installation package has been downloaded, it should be launched by a user with administrator rights on the target computer (server).  After verifying the included files, a window will open:



Select the "New SQL Server..." option and step through the next windows while it checks for prerequisites to reach this window to confirm a new installation of SQL Server:



Continue by accepting the license terms, and then select appropriate features.  
As a minimum, select Database Engine Services (uncheck SQL Server Replication).  

Next give the "instance" of SQL Server a name (don't use Default instance).  This name will be used later when specifying to ShelterBase Server which instance to use for the database.


The default Service Accounts under which SQL Server will run are normally successful.  If necessary, this can be changed later using the Windows services.msc applet.  For security purposes, the SQL Server Browser service should be set to Disabled unless there is a specific requirement for it to run.



The authentication mode must be changed from the default to "Mixed Mode".  Enter a password for the built-in "sa" account as well.  The location for storing data can also be changed from the default if disk requirements or backup methodology dictate.  Otherwise, data will be stored in a folder such as "C:\Program Files\Microsoft SQL Server\MSSQL11.SQLEXPRESS\MSSQL\DATA".



Step through the remaining options until the actual installation begins, which will take several minutes.

SQL Server Management Studio

Install SQL Server Management Studio (SSMS) after the installation of SQL Server is complete.  Click the “Install SQL Server Data Tools” link in the SQL Server Installation Center window, which will open your default browser to appropriate Microsoft download web page.  From there, download and run the current setup package for SSMS.


[bookmark: SBserver]ShelterBase Server (and Configuration Tool)

ShelterBase Server should be installed on the same computer as SQL Server.  This reduces security issues that arise when exposing SQL Server to the network as well as improving performance.  The installation package must be performed by a user with administrator privileges on the target computer.  For most instances, the user should accept the default settings during installation.  Since ShelterBase Server runs as a Windows service, there is no user interface to access settings.  The ShelterBase Server Configuration Tool must therefore be installed after the server component's installation.

Once installed, launch the configuration tool from the ShelterBase folder on the Start menu, which will display this window:



The configuration tool is used to tell ShelterBase Server the following items on startup:

· The SQL Server instance that contains the ShelterBase database, given as "<ComputerName>\<SQL Instance Name>". 
· The timeout in seconds that the server will wait for a response from the database; default is 5 seconds. 
· Whether a ShelterBase client installed on the same (server) computer will access the database. 
· Whether to allow network clients to access the database, and if so, which port(s) to use. 
· If running on a network with a domain controller, whether to use that controller for additional user authentication.
· The SQL Server instance hosting the ShelterBase database should be selected in the dropdown box.  For most cases, the timeout should be set to 5 seconds, although it may be necessary to increase the setting on overworked servers.

If the ShelterBase client is to be installed on the same computer as the server components, the "Local Clients" checkbox should be checked.  If clients will be accessing the program via a network connection, that checkbox needs to be checked as well.  Additionally, to open the server to the network, one or more "ports" must be added to tell the server where to "listen" for requests.  The default is 8000, but other available ports may be used in addition to or instead of the default.  Note that when subsequently configuring client applications it is necessary to identify a port that matches one in the list (usually there's only one).  Additionally, selection of "Domain controller authentication", which only applies to networks with a domain controller, must be the same on both the server and client configuration.

The completed configuration should look something like:



When the configuration is correct, click "Apply" to save the settings, then click the "Start ShelterBase Server" to launch the Windows service.

[bookmark: CreateDB]First-time installations only:

When ShelterBase is being installed for organizations who have not used it before, i.e., no previous data, it is necessary to create an empty database.  This is accomplished by selecting “Create Database…” from the File menu.



Log in to the SQL Server instance either using the just-created “sa” user and password, or check the Windows log in box and login with Windows authentication.



After a successful log in, click “Next”.



Click the “Create….” button to complete the process.



Click “Finish” once the database has been completed. 


Important:  If clients will connect to ShelterBase Server over a network, ensure that firewall software is configured to allow access.  For example, if using the Windows firewall, access its applet via Control Panel.  In the resulting window, select "Allow a program or feature through Windows Firewall".



In the resulting window, click the "Allow another program..." button, which will open this window:



Click on the "Browse" button, which will open a standard file browser.  Navigate to C:\Program Files (x86)\ShelterBase Server (64 bit Windows) or C:\Program Files\ShelterBase Server (32 bit Windows):



Select the ShelterBaseServer.exe file, which will add it to the list of programs allowed to communicate through the Windows Firewall.  If using a third party firewall, consult its documentation for procedures on allowing a program to access the network.

A final task to assist network client connections is to turn on “Network discovery” on the server computer.  This will enable network clients to user the server computer’s network ID during initial client installation.  


[bookmark: Client]ShelterBase Client

The ShelterBase "client" is the program where users perform actual database operations, i.e., it's the only part of the application that most users ever see.  When using ClickOnce deployment from the web site, it installs on a per user basis, which means users sharing the same computer with different log in credentials will need to perform their own installations.  Since ClickOnce installs the program in the individual users' folder, it does not require administrator rights.  Conversely, if a standard setup program is used for installation, it must be run with administrator rights.  Generally, the defaults should be accepted unless local requirements dictate otherwise.  Note:  When installing from the web site, a security warning may be issued because there is not a current certificate.  Select "Run Anyway" (or the equivalent browser option) to complete the installation.  As ClickOnce is a Microsoft technology, it often works best using the Internet Explorer or Edge browser.

When the program is run for the first time it will ask the user to locate the server components.  If the client is installed on the same computer as the server, select the first option and click OK.



If the server is installed on a different computer on the network, select the second option.  Click the Computer Name dropdown, and it will populate with the names of computers discovered on the network.  Select the appropriate computer name, then enter one of the ports that was established when ShelterBase Server was configured.  If on a domain network and Domain controller authentication is desired, check that option as well (it must be the same as the authentication option on the server).  Finally, click OK when the correct options have been selected.


 
Note:  In some cases, the computer list may not display the server's computer name.  This is not uncommon on Microsoft networks in various configurations.  The correct server name can be typed directly into the Computer Name box.  Alternatively, if name resolution fails, the server's IP address, e.g., 192.168.0.10, may be entered instead of the computer name.  If this is the case, the server should be configured with a static IP address.

If a successful connection to the server is established, a ShelterBase log in window is displayed.  The program will subsequently "remember" the connection information.



If this is the first use of ShelterBase, the only current User Name is "sa" and the password is the one established during the Microsoft SQL Server installation.  Enter a current name and password, and the ShelterBase program will launch. 

 

 

 
[bookmark: Lesson3]
Lesson 3:  Setup

The most important step to ensure reliable and usable reporting is to set up the software according to the needs of the shelter.  ShelterBase is designed to allow organizations to configure the program according to their unique requirements.  Enabling that flexibility creates the requirement for shelters to plan the software’s configuration before entering the first client record.  Failing to accomplish this task is probably the leading cause of unreliable reporting.

[bookmark: UserAccounts]User Accounts

After initial installation there is only one user account on the database that can be accessed by ShelterBase.  The “sa” (system administrator) account, including the password, must be used for the first login.  Once logged in, select “Manage Users” from the Admin menu.  Then create additional users by clicking the New button, then enter a unique user login name and password.  Also select the appropriate security role for the new user, which can be:

· SysAdmin:  A database administrator can see and edit all data, as well as create/edit user log-ins.  Administrative tools such as backup/restore and delete/undelete records are only available to administrator log-ins. 
· Staff Data Users can see and edit all client and staff data, including potentially confidential staff information. 
· Client Data Users can see and edit all client data, but only basic staff information, e.g., name and title. 
· Limited Users can create basic client and intake records, but cannot view extended intake information.  Additionally, they can enter client activity data:  services, referrals, notes, questionnaires. 
· Hotline Users can only enter hotline/walk-in records. 
· Read Only Users can view all information in the database, but cannot enter or edit records (useful for personnel who need access to information but are not involved in data entry).

Click OK to complete creation of the user account, and add additional accounts as necessary.  Be advised that while the shelter’s admin user can perform this task, shelters will routinely call for support to create new accounts.  While providing this support it’s a good idea to also confirm that existing accounts are still current as the database administrator(s) often fail to delete accounts of staff that have left the organization.


[bookmark: OrgData]Organization Data

This information is entered by selecting “Organization Data” from the Shelter menu.  As a minimum enter the organization’s name as it will appear in most of the reports.

[bookmark: Shelters]Shelters

It’s important to understand that a “Shelter” in ShelterBase is NOT the same as the organization.  Instead, “Shelters” are units within the organization that perform client intakes.  There may be more than one shelter within the organization, but there must be at least one.

Smaller organizations may want to create only one shelter which performs both residential and non-residential intakes.  Alternatively, they may elect to separate their clients within the database by creating separate shelters, one for crisis and another for non-residents (outpatients).  Note:  DES reporting is based on data from shelters that have been linked to a DES grant, so it may be necessary to create separate shelters for non-funded clients.

To create shelters, select “Shelters” from the Shelter menu, and click “New” in the resulting window. 

Give each shelter a unique name, and select whether it is an actual shelter, motel, or private residence.  If an existing shelter is discontinued, uncheck the "Current" selection to remove it from lists in other windows; do not delete it, as it may be referenced in related intake records.

Shelters must be one of three types:

1. Crisis (aka Emergency) 
2. Transitional 
3. Other (used for non-domestic violence clients)

A Crisis shelter needs to be further defined as to whether it is Residential and/or NonResidential, and whether it maintains a Hotline for crisis and referral calls.

Finally, a shelter must be assigned to a "Campus", i.e., a geographical location that can contain more than one shelter, e.g., residential and non-residential crisis shelters.


[bookmark: RoomsBeds]Rooms and Beds

After residential shelter records have been created, rooms (aka units) and beds should be added.  This is necessary for accurate reporting to some funders; for example, the active beds in a crisis shelter for a given report period are included in the DES quarterly report, and "rooms" are reported as transitional "units".   Entering room/bed information is also useful for tracking bed assignments to clients.

Typically “Rooms” are entered first, indicating which shelter they are assigned, a unique room number, and the date they entered service.  Should a room be deactivated at a later date, the date it entered service should be entered (do NOT delete the room).  The service dates of rooms are used to determine unit availability during specified report periods.

Beds are entered in the same manner as rooms.  A “bed” may be annotated as a “crib” where appropriate, in which case it will not be included in the bed count for the DES report.

The final step in the process is to assign beds to appropriate rooms on a specified date, usually the date the room and bed were placed in service.  This is done on the “Room/Bed Assignments” tab of the Shelter window.  Select the shelter and the date the bed was assigned to the room, then drag/drop the bed into the room and confirm the assignment.  If an error is made, the assignment can be deleted by selecting it in the “Bed Location History” list and clicking Delete.

The bed assignment model allows beds to be moved between rooms, but care must be take to enter the correct date when making moves.  Historically, this capability has seldom been used by shelters. 


[bookmark: Surveys]Surveys

Surveys should be created for measuring core outcomes prescribed by funding agencies as well as metrics devised by the shelter.   If set up properly, their results are compiled into some funder reports, e.g., the DES DVSR.   They are created or edited by selecting "Surveys" from the Tools menu.  




Core outcomes used for VOCA, ACJC, and DES reporting are pre-installed in the application, subdivided into “goals”:

	Goal
	Outcome

	VOCA

	Healing
	Victim reports an increased knowledge of services available. 1, 2
Victims report an increased knowledge and understanding of domestic violence and its effect on their life. 
Victim reports feeling believed/not alone. 
Victim reports they are (re)gaining control of their lives. 
Victim reports having increased feelings of well-being. 1
Victims report they know how to access short and long-term resources that meet their emotional and safety needs. 1

	Justice
	Victim reports having an increased understanding of their legal rights. 1

	Safety
	Victim reports knowing how to plan for continued safety. 2 
Victim reports that safety has improved. 2

	Quality Measures
	Victim expresses satisfaction with services. 1

	
	

	Additional ACJC Outcomes

	Healing
	Victim reports the provider’s services increased ability to cope.
Victim completed treatment plan objectives.

	Justice
	Victim reports the information and assistance provided had a positive impact on participation in the criminal justice system.
Victims reports increased knowledge of the legal system.

	Economic
Stabilization
	Victim reports an increased knowledge of the victim’s compensation program, restitution and other financial assistance services.

	Safety
	Victim reports understanding and initiating safety plans for meeting immediate and on-going safety needs.  (Note:  May be the same as first VOCA safety outcome.)
Victim reports being able to better assess safety needs.

	Quality Measures
	Victim reports they would recommend program services to other victims.
Victim reports that advocacy services provided were helpful.

	
	

	1Included in ACJC outcomes
2Mandatory DES reported outcome



Create a survey by clicking the “New” button, then:

1. Enter a unique name for the survey
2. Check or uncheck the "Anonymous" option which determines whether or not completed questionnaires must show the associated clients.  
3. In the "Qualitative Questions" list, check which questions will be used to measure the associated outcome.  When the question is checked, the user should also enter the question number that will be printed on the questionnaire, which wil also be the order the questions are displayed when entering results.



Narrative items can also be added to the survey by a slow double-click on the "<Add new narrative item>" in the Narrative Questions list.  Type the narrative question, then click elsewhere in the list; additional questions can be added in the same manner.



Click OK to save the survey.  Once saved, questionnaires can be printed or saved in PDF format by clicking the "Print" button.  To edit an existing survey, select it from the dropdown list and click the "Edit" button.  Note:  Once questionnaires have been entered for a survey, only its name, associated grants, expiration status, and question numbers can be edited.

Organizations can add their own outcomes for survey measurement via the “Edit Questions” tab.  



Click the “New” button to create a new outcome and question used to measure it.  While using a 5-point Likert scale is recommended (and required for the funder outcomes), users can also use a scale up to 20 or create True/False questions.  The added outcomes may be added to existing goals the users can create a new goal/category.  



FVPSA grant recipients from AZ Department of Health Services or tribal funders (e.g., Navajo Nation):

For survey results to be properly reflected in the associated grant reports, up to eight (8) survey questions should be annotated in the "For ADHS/FVPSA" section.  Four "Safety" outcomes for Shelter, Support Services/Advocacy, Counseling, and Support Group must be designated, as well as four "Resource" outcomes for the same areas.  If more than eight such questions are used in surveys linked to an FVPSA grant, the report may indicate more responses than there are surveys.


[bookmark: Grants]Grants

All grants from supported funders need to be entered by selecting “Grants & Grantors” from the Shelter menu.  Many funder reports will not populate unless there is a current, corresponding grant recorded.



Click the “Enter Records” button to enter new grants.  The window will change to edit mode, where the grantor, contract number, and grant start/end dates are entered.



Additionally, for ACJC, DES, and VOCA, additional selections must be made in the “Grant Targets” group.

· DES, ACJC:  Check the shelters to which the grants apply.  The associated reports will then compile data for all clients with intakes in the selected shelter(s) as well as hotline callers.
· VOCA:  Check the funded shelters, programs, and/or staff.
· Shelter(s):  The VOCA report will include clients and services rendered for all victims with a residential intake during the report period, and for non-residential victims who received a grant-related service during that period.
· Program(s):  The VOCA report will include all victims who received a grant-related service from the selected programs.
· Staff:  The VOCA report will include all victims who received a service from the selected staff member(s).  This is used when the VOCA grant funds a specific staff position.
· Note:  Duplicate records for victims who are served by shelter/program/staff selection are not reported, i.e., the count is for unique elements.



[bookmark: Services]Services and Programs

The most important setup task, and the one requiring the most planning, is creating a list of services provided to clients that correspond accurately to the plethora of service types reported to funding agencies.  Due to the disparate nature of funder service types and definitions, shelters need to ensure their list of services, including sub-categories called “focus”, are sufficiently granular such that they are properly credited for the work they have performed.

As an example, a DES service type is “Case Management”, which is implemented by most shelters.  However, that is an extremely broad definition that may encompass several service types reported for grants such as VOCA.  In this case several types of focus should be created to further sub-divide the case management service.  The same situation also applies to services such as “Legal Advocacy”, as many funders have more specific requirements, e.g., criminal vs. civil, as well as types of civil legal advocacy.

Services, Programs, Focuses, and “Mapping” of services to funder service types is accomplished by selecting “Services & Programs” from the Shelter menu.



Services

To create a new Service, click “New” and enter a unique service name.  If it is a service that can be administered simultaneously to multiple clients, select the “Group” box.  Also indicate if the service is provided by phone and/or in person.  Service available by phone will be listed when entering them via the hotline window.  Click OK to save and continue adding additional services.

Programs

It’s important to understand that a “Program” in ShelterBase is nothing more than a grouping of services.  A service must belong to one or more programs.  Programs exist only to allow organizations to separate services rendered for reporting purposes.  Only one Program should be created if there is no need to separate the services provided, and all services should be linked to that program.

To create a program, click New on the Programs tab, enter a unique program name, and place a check for each service associated with the program.


Focuses

As previously noted, a focus is just a sub-category of a shelter service.  Adding these sub-categories to appropriate services obviates the need to create large lists of services to align with the various funder service types.  A focus can be associated with more than one service, e.g., the same focus may apply to services of Individual Counseling and Group Counseling.  Note:  By default, each service has a default focus of <None>.

To create a focus, click New on the Service Focuses tab and enter a unique name.  Then place a check next to each service type to which the focus applies (usually just one).


Map Services to Grantor Service Types

The process of “mapping” shelter service types (including focus) to funder service categories is both simple and commonly misunderstood.  The mapping procedure simply tells ShelterBase how to report shelter defined services to different funders.  For example, a shelter service of Legal Advocacy with a focus of Immigration Assistance would be mapped (reported) to DES as Legal Advocacy, but would be mapped (reported) to VOCA as Immigration Assistance.

Warning:  Users routinely think their reporting issues are due to incorrectly mapping their services.  In nearly all cases, their problem was insufficiently defining their menu of services before mapping them to the funder service types.

Select the mapping tab on the Service & Programs window:



Mapping must be accomplished for every applicable funder.  Start by selecting a grant agency in the center drop down list.



The left-most list populate with unmapped services.  The plain text entries represent a shelter service type with a focus of <None>, while the italicized entries represent sub-categories (focus) of the preceding service.  All that is required is to select a shelter service from the left list, the corresponding funder service in the center, and click the “Map to” button.  If a top-level (plain text) service is selected, ALL of its sub-categories will be simultaneously mapped to the selected funder service type.



Continue selecting shelter services and the corresponding funder service types.  Note that some shelter services do not correspond to the funder definitions, so those sessions will not be reported.




[bookmark: Phases]Intake Phases & Tasks

Intake phases and tasks are optional features that can be used to manage participant progress during an intake.  Both phases and tasks are applicable to specific intake types.  Reports are available to reflect participants' phase and task completion status.

Intake Phases

Phases for different intake types are entered by selecting Intake Phases from the Shelter menu.


To enter phases, click the "Enter Records" button.



Enter the name of the new phase, the type of intake to which it applies, its sequence during the intake period, and its nominal length.  Click OK to save the record, and continue entering additional phases.  When done, click the "Show Records" button to see the list of entered phases.




Intake Tasks

A list of standard tasks associated with specific intake types can be created by selecting Intake Tasks from the Shelter menu.



Enter new tasks by clicking the “Enter Records” button.



Enter a unique name for the task and select the type of intake to which it applies.  Also enter the number of days from entry to complete the task.  Click OK to save the record, and continue entering additional tasks.  When complete, click the "Show Records" button to display a list of entered tasks.


[bookmark: Lesson4]
Lesson 4:  Staff

[bookmark: MemberData]Member Data

Before entering client service and referral records, it's important to enter at least basic information on the organization's staff members, particularly those who provide services to clients.  The "Staff" category includes full-time, part-time, and volunteer members.  Staff data entry is accomplished by selecting “Members” from the Staff menu. 



Click the “Enter Records” button to enter additional staff members or click “Edit” to update the staff member selected in the list.   Most users will then see:



Administrative and Staff Data Users will see:



Basic staff information includes name, title, and employment status.  If the member is to be listed when entering client service sessions or referrals, the "Provides services to clients" box should be checked as well.

Authorized users can view/edit additional staff data which is potentially confidential.  None of this information is utilized in the program’s reports.



The "Requirements" tab displays credentials that were entered as "Required" and lists those that apply to the selected member.  



[bookmark: Credentials]Credentials

Staff "Credentials" can include any items that can or must be accomplished by staff members.  This can include training subjects, such as CPR training, or non-training events such as TB testing.  Credentials can be entered by selecting "Credentials" from the Staff menu, which will display this window:



Create a new credential by clicking the “Enter Records” button.



The new credential must have a unique name.  If the “Training/Academic” box is checked, the credential will be added to the list of possible training topics in the Staff Training window.  

Check the “Requirement” box if the credential can mandatory for a staff member.  If so, indicate how often the requirement must be completed:

1. NonRecurring requirements are only accomplished once, e.g., orientation.
2. A Manual Expiration can be assigned to requirements such as a driver’s license.
3. For repeating requirements enter how often (in months) the task must be repeated.

[bookmark: Training]
Staff Training

Education and training sessions for staff members can be recorded by selecting "Training" from the Staff menu.



The "Subject" dropdown list contains all credentials that were created with the "Training/Academic Subject" box checked.  Select the subject and date of the training, enter the number of training hours, and select which staff members received the training.  Preparation time, facilitators, and session notes may optionally be entered.



If the subject (credential) was defined as a "requirement", a dialog will offer to update the completion date for those staff that have that subject listed as one of their requirements.  Check the names of the members for which the training fulfilled the requirement (this eliminates the necessity of updating requirements individually in the extended staff data window).  Do NOT check the members in cases where the training doesn't complete the requirement, e.g., only 4 hours of an 8 hour requirement. 



If the requirement was updated, it will be reflected on the "Requirements" tab of the affected members' staff data.


[bookmark: Outreach]
Staff Outreach

Staff outreach includes presentations and community awareness activities.  Presentations are made to a defined audience at a specific time, whereas community awareness activities include events such as health fairs and information booths.  Both functions can be recorded by selecting the "Outreach" option from the Staff menu.




Presentations

Presentation records must include the location, presentation date, the length in hours/minutes, the number of people attending, staff members making the presentation, the topic(s) presented, and whether the event was targeted for adults or youth.  The user may also enter preparation time for the event, as well as attach a note.



To add a new topic to the list, click the "New" button and enter a unique topic.  Note:  Topics added to the list should be general in nature to prevent the list from becoming over-populated with similar entries.



Click the "Save" button to re-populate the topics list with the new entry.  To change an entry, select the item and click the "Edit" button, and either change the entry or uncheck the "Current" box to remove it from the list of current topics.


Community Awareness Activities

The only required entry for a Community Awareness Activity is the date of the event; all other items are optional.


[bookmark: Volunteer]
Volunteer Activities

Two types of volunteer activities can be tracked for reporting purposes:

1. Personnel actually listed as part of the organization's staff with a status of volunteer 
2. One-time or occasional volunteers, possibly anonymous, participating in an activity such as facility painting

Volunteer activity records can be entered by selecting "Volunteer Activities" from the Staff menu.




The type of activity and date must be entered.



For staff volunteers, check those who participated.  When checked, the activity time is also entered, either in hour/minutes format (1:30) or as decimal hours (1.5).



Note:  Services provided to clients by staff volunteers should NOT be recorded here; those hours are derived from service session records.

Time contributed by non-staff volunteers can be added to the same record or in a separate record by entering the number of volunteers and the length of the activity.  The time provided is the same for each person.





[bookmark: Lesson5]
Lesson 5:  Client Data Entry

[bookmark: Definitions]Definitions

The client data collected by ShelterBase is modeled using the following definitions to allow compilation to meet various funder requirements:

Intake: A client intake represents a discrete period of service provided to that client. A client may have multiple, non-overlapping intakes representing different periods of service. For clients participating as Community Members, an intake is not created as there is no discrete period of service.

Intake Types:   Intakes are divided into six distinct types:
1. Crisis: A residential intake for a domestic violence victim including any accompanying children. 
2. Homeless: A residential intake provided for a homeless person and any accompanying children. 
3. Transitional: A residential intake for participants and accompanying children in a transitional housing facility. 
4. Non-resident DV: A non-residential intake providing out-patient services to domestic violence victims, including their children if applicable. 
5. Non-resident Other: Optional non-resident client type that is NOT related to domestic violence. 
6. Resident Other: Optional resident client type other than crisis, homeless, or transitional (usually not included in funder reports). 

Client Types: There are four types of clients: 
1. Participants: The direct recipient of services for domestic violence victims, aka primary clients. 
2. Children: Dependents accompanying the participant, either as residents or non-residents, receiving shelter services. 
3. Abusers: Persons with history of domestic abuse receiving services, e.g., counseling. 
4. Community Clients: Persons receiving services without undergoing a formal "intake"; less demographic information is generally captured for these individuals.


[bookmark: DataCollection]Data Collection

Data entry for clients is best facilitated if shelter procedures ensure that information is entered in the following chronological order:

· Hotline call/walk-in, particularly those where shelter is requested 
· Create new Participant record (if not a returning client) 
· Enter the basic intake record 
· Complete the extended (complete) intake record 
· During the client's intake, enter activities completed:
1. Service sessions provided 
2. Referrals made 
3. Client notes 
4. Questionnaires completed 
5. Changes to bed assignment 
6. Information release permissions 
7. Self-Sufficiency assessments
· Exit data
[bookmark: DataEntry]Data Entry

Several different windows are used to enter various types of data.  Some types of windows can be displayed as multiple instances, e.g., several Participant windows can be open at the same time.  On the other hand, many data entry windows can only be opened in single instances.  Most of these "single-instance" windows have two modes:

1. List mode, where records within a date range are listed. 
2. Data entry mode, where new records are entered or existing records edited.

In List mode, the window will appear similar to:



Records are included in the list based either upon their "event" date, e.g., the date of a hotline call, or the date they were last edited.  The window will open with a default date selection range, but the user can change the range and click "Refresh" to repopulate the list.  The list can usually be resorted based on a particular column when the user clicks the column header.

A record in the list can be deleted by selecting it and clicking the "Delete" button.  Editing a record is accomplished by double-clicking a list item, or by selecting it and clicking the "Edit" button.  New records can be entered by clicking the "Enter Records" button.  Either case will change the window to data entry mode:



Data for the record type is entered where indicated.  If editing an existing record the "Created" and "Updated" labels at the bottom will indicate when and by whom the record was originally created and most recently edited.

Client dropdown lists will show the client's name and DOB.  When the list is restricted to "current" clients (default), only clients with a current intake (no exit date) or who exited in the last 30 days are available.

There are two styles of dropdown lists used in ShelterBase.  If the user can add items to the list by typing an entry, its background will be similar to the participant list above.  In this case, the user will be asked to confirm if the new item should be permanently added to the list.  Fixed lists have a darker background and the user must select from existing items.
[bookmark: Hotline]
Hotline Calls & Walk-Ins

Typically the first contact with a potential client is via a hotline call or walk-in situation.  Records for these contacts are entered by selecting "New Call" from the File menu or clicking the Hotline button on the toolbar.  The Hotline window will open in the data entry mode.



Select whether the record is for a hotline call or a walk-in situation.  If there is only one shelter with a hotline, it will automatically be selected; otherwise, select which shelter received the call.  Enter the date of the event (the default is the current date), the name or alias for the client, number of children if reported, and the sex of the caller.  The type of call must also be selected, usually "Crisis" for a domestic violence incident or shelter request, or "Info/Referral" for non-crisis situations ("Other" is only used for non-hotline subject calls, e.g., donations; it should not normally be used).  The call subject, usually Domestic Violence, should be selected as well as the referral source and origin location, if known.



If shelter is requested, the box should be checked and the Request Outcome selected.


If multiple calls are entered for the same person for essentially the same incident, only one should indicate a shelter request and outcome, particularly if "Provided Shelter..." is selected.  Otherwise, the number of unique shelter requests will be inflated for reporting purposes.  Typically, the first call requesting shelter will indicate the request and outcome, while subsequent "progress" calls should NOT reflect additional requests.

If shelter was not provided after a request, the Reason Denied must be entered.  If a referral is made when a request is denied, the referred hotline can be checked from the list; additional hotlines can be added to the list using the "Add" button.



If services are provided during the call, select the “Services” tab.



Check the “Services Provided” box to allow service data entry.



Select the type of service (focus is optional) and the program if required (if the service is only associated with one program, it will automatically be selected).  The time and number of staff providing the service must also be entered.  Selection of the specific staff providing the service in the staff list is optional.  Once completed, click the "Add" button.  If additional services were provided, enter their information as well.



Once all the call data is entered, click "OK" and the window will reset to allow entry of the next record.

To review call/walk-in records that have already been entered, click the "Show Calls" button.  The list can be refreshed for different date ranges, as desired.

[bookmark: Participants]
Participant and Child Information

Basic information must be entered for participants and their children before more detailed data is captured, such as initial intake information.  This captures information about the individual that normally doesn't change, such as date-of-birth and ethnicity.  Information about the prospective participant and any accompanying children includes:

1. Basic Participant information 
2. Basic Child information (optional if not accompanying participant) 
3. Emergency contacts (optional) 
4. Participant Alias(es) (optional) 
5. Participant Files (optional)

Additionally, lists of intakes, services, referrals, and notes are displayed on the corresponding tabs, allowing quick access and review of those items.

Participants

Client information is originally captured in a new Participant window by selecting "New Participant" from the File menu or clicking the New Participant button on the toolbar.



As a minimum, the first name, last name, sex, and date-of-birth must be entered.  A social security may optionally be entered.  In additional, if an internal ID system is used, that identifier may be entered in the "Opt'l ID" box.  Race/Ethnicity information should be entered if known.  Furthermore, if "Native American" or "Mixed" is selected, tribal affiliation may be selected/entered as well.  When minimum and optional entries are complete, click the "OK" button to enter additional information.

The first time that a new participant record is saved, ShelterBase will compare the date-of-birth to other records and provide the user with a list of any participants having the same date-of-birth.  If the participant already exists in the list, close the window and open the existing record to add any additional information.



Important:  Once a participant record has been created for an individual, do NOT create additional (duplicated) records if that person subsequently returns for another period of services.  In such cases, create a new intake record for the returning client.

Children

Child information is displayed and entered on the “Children” tab.




Click “New” to enter each child’s information; as a minimum, enter the first name, last name, sex, and date-of-birth.



Click “OK” to save each child’s record; continue to use the “New” button to enter additional children.



(Emergency) Contacts

If available, emergency or other contacts may be entered on the "Contacts" tab.



Click "New" to enter each contact.  As a minimum, a name must be entered.



Alias(es)

The participant's record can be accessed by more than one name if one or more aliases are entered on the "Aliases" tab.



Click “New” to enter each alias.



Participant Files

Disk files, such as PDF documents or JPG images, can be saved to the database by selecting the "Files" tab. Note: Saving disk files larger than 250 KB is NOT recommended. Entering a several files of large size will quicklyl increase the size of the database as well as the backup files.



Click the “New” button to select a file to save to the database.



For an existing file, click the "Select File" button; in the resulting dialog, navigate to and select the desired file.  By default, the dialog will show only PDF files.  The user can change the filter to JPG or All Files.



If desired, the file can be saved with a different name (but not a different extension) by checking the "Save file with new name" box and entering the alternative name.



Click "OK" to save the file to the database; it will be added to the list of participant files.



If desired, an image can be scanned directly into a jpg file by clicking the "Scan Image" button.  If multiple scanners are available, the user selects which scanner to use from a list.



Select the desired scanner from the list and click "OK"; if only one scanner is detected, it will automatically be selected.  A scan options window will open based on the selected scanner's capabilities.


Normally, the "Preview" button should be clicked first, which will present a pre-scan where the user can crop the image as desired.  After the "Scan" button is clicked and scanning is complete the user must enter a name for the file, then click "OK" to save it to the database.
[bookmark: Intakes]
Intake Records

Basic Intake

Once the participant record has been saved, it is necessary to create a basic intake record.  This essentially turns the participant into an active client that will receive shelter and/or services.  This step captures the minimum information necessary and is intentionally limited to avoid subjecting a recently arrived client from extensive interview questions, possibly after a domestic violence incident.  Extended intake information should subsequently be entered within a few days of the client's entry.

An intake is created by selecting the "Intakes" tab in the participant's window and clicking the "New" button.  This will open a window to enter initial intake data, i.e., entry date, intake type, and shelter.



In addition to entering the first three elements, the user should "check" any children who will accompany the participant into the shelter.  This will create an intake record for the child as part of the parent's intake record.

If the intake type is residential (Crisis, Transitional, Homeless, or Other Resident), the Bed Assignments list will populate with the beds associated with the shelter's campus.



At this point, the new residents may be assigned to specific beds by dragging-and-dropping them from the left list into the assigned bed.  If the client is inadvertently "dropped" into the wrong bed, simply move them via drag-and-drop into the correct bed.



When all the entries are complete, click "OK" to save the record.  If the intake type is Crisis or Homeless, the user will be prompted to link the intake to the hotline record initiated the intake.



Selecting "Yes" will open a window with two lists:  the Crisis/Homeless intake of the participant on the left, and all call/walk-in records where the request outcome as "Shelter Provided..." that are not already linked to an intake.  By default, only calls with a week before the actual intake are shown; the user can modify the list by changing the "From" date.



To link the call, simply select the intake on the left and the appropriate call record on the right, and click the "Link" button, then close the window.

Note:  It's very important that call/walk-in records that reflect "Shelter Provided" are linked to theit corresponding intakes.  Since call records are normally entered before the intake record, it's not uncommon for the caller to fail to show, such that the reflected outcome of providing shelter is incorrect.  These calls will appear in the Delinquent Items window, where their outcome should be changed to "No Show".  If the hotline record is not entered before the initial intake record, it can later be associated with the call using the Link Calls to Intakes window.

If the basic intake is successfully saved, the "Open Full Intake Data" is enabled to allow the user to continue entering extended intake information.


Extended Intake

Shortly after a basic intake record has been saved, users should enter additional information, much of which is used for reporting to funders.  This includes:

· Participant entry data:  Incident, Abuser History, Demographic information, Residence, Health, and Income information.
· Child Intake Data:  Abuse History, Income sources, Health

Opening a participant’s intake window can be accomplished by:

· The “Open Full Intake Data” button on the basic intake window
· Selecting the participant in the Find Client window and clicking the “Intake” button (only for current intakes)
· Opening the participant’s window and double-clicking the intake on the “Intakes” tab (or select the intake and click “Edit”)

This will display the data entry window for this specific intake.  Information should be entered in the first two tabs, along with any child tabs, as soon as possible after the participant has begun receiving shelter and/or services.

On the "Entry Data" tab it is especially important to enter the type of victimization for VOCA-related grants, especially where the intake type is "Crisis".  Once entries are completed for this page, select the "Client Data" tab.




Once entries are completed for this page, select the “Client Data” tab.



In the Residence section, it's important to note the participant's county of residence and reservation, if applicable.  Health information is also largely reportable to a number of funders, who are usually extremely interested in the participant's income level and sources.  Note:  Indicate the sources that apply to the individual at entry; any changes will be reflected when the exit information is entered.  Enter the income amount in either the monthly or annual box; the equivalent rate will be reflected in both.

In addition to sources, the "TANF Eligible" should be checked for appropriate participants.  Hovering the mouse over the checkbox will display an income guide to help make this determination.



Child Intake Data

When the original participant record was created, basic child data was included.  A tab for each listed child is then created in the intake window.  Additional information must be entered for each child that was "checked" in the basic intake window, i.e., accompanied the participant in shelter.



Information should be completed in the same manner as the parent's data.  Note that the child's entry date must be the same or after the parent's, and the final exit date must be the same or prior to the parent's exit.

Additionally, in cases where the child temporarily exits shelter but returns while the parent's intake is still active, the "Absences from Shelter" can be entered.  For residential intakes, this will subtract applicable bednights in the DES quarterly report; if the bed is kept open for the child, it may be appropriate to neglect any temporary absences.

Administrative Intake Data

The "Admin" tab of the intake window is used to view, enter, and edit additional information corresponding to the intake.



This page allows users to view and/or edit lists pertaining to the client’s intake.

· Assigned Staff:  The "Assigned Staff" list reflects what members, if any, have specific responsibility during the participant's intake.
· Completed surveys and Self-Sufficiency Assessments associated with the intake.
· Intake phase and task completion dates.
· Reports specific to the intake.

Progress Tab

Data for the DES Housing Intervention Performance Measures report is captured on the “Progress” tab.



Additional data for the report should also be entered on each child’s tab of the intake record.



Exit Information

Exit data should be entered as soon as possible after a participant leaves the shelter or ends non-residential services.  As a minimum, the exit date for the participant and any accompanying children must be entered, particularly for residential clients, so the bednight computations and bed availability are accurately reflected.

It is important to enter exit information for inactive non-resident clients, i.e., those who have not received services for an extended period of time.  For these cases, enter an exit date corresponding to the last date of service along with any known information.  If the client subsequently returns for additional assistance, a new intake record should be created to reflect updated information such as income.  Also, these returning clients will again be counted as "new" for most reporting purposes.



If all exit information is entered, check the "Exit Data Complete" box to eliminate notices on the delinquent items list.  Click OK to save the exit record.

If the participant's children accompanied the client, enter those exit dates as well.  A child's exit date can be no later than the parent's.


[bookmark: Community]
Community Clients

Community Clients are persons who receive services without undergoing a formal "intake"; less demographic information is captured for these individuals so the detailed intake record is not accomplished.  Because this makes less data available for comprehensive reporting, providing services on this basis should be limited to cases where it is impractical to capture information to the same degree as participant intakes and there are a limited number of service sessions.

A new community client record is created by selecting Community Client from the File | New menu.  Alternatively, the New Client toolbar button, which by default displays the New Participant button, can be changed by clicking the dropdown arrow and selecting and clicking the New Community Client button.



The resulting window is similar to the participant record with two significant exceptions.  Since there is no intake record, the "Current/Active" checkbox is used to add or remove the individual from client lists when entering activities such as service records.  A "Victimization" entry is also available to include the client in related reports.  The only required entries are for first and last name (or alias) and sex; if date-of-birth is not entered, the client's age will be listed as "Unknown" in various reports.
[bookmark: ServiceSessions]
Service Sessions

Records of services provided to clients are entered by selecting "Service Sessions" on the Activities menu or clicking the services  button on the toolbar.  In the resulting window the user enters the service session information, and may optionally enter session notes, trip log data when client transport is involved, and/or information on tangible goods that were distributed.



Session data must include the date and type of service, the program under which it was administered, the session length, and the number of staff providing the service.  The specific staff member(s) providing the service can also be checked in the staff list.  If there is only one program associated with a service type, it will automatically be selected when the service is selected.

For services to individuals, once the session data is entered, the user must select the client receiving the service as well as the intake during which the service was rendered (N/A for Community clients).  The intake will be automatically selected if the service date is within the intake period.   Since nearly all services are rendered during an intake, it's very important to ensure the correct intake is selected when entering service records.  In rare cases where a one-time service is given without a corresponding intake, the user may select "Service NOT during an intake period".



If the service being provided was created as a "group" service, the group controls will be active.



Clients must be selected and added one at a time to the group.



Continue selecting and adding until all clients in the session are in the Group box.



To expedite data entry, additional data entry options are available.



· When there are multiple service sessions of the same type provided to different clients, check the "Retain all session data between entries" option.  In this case, after saving the record, the user only needs to select the next client(s) for subsequent records. 
· When more than one service is provided to the same client, check the "Retain client between entries".  After saving each record, the user only needs to enter the session information.  Note:  This option is not available for group services. 
· In cases where the session data (date/type/length/staff) is the same for multiple sessions for the same client, enter the "Number of identical sessions" and that many records will be created when the OK button is clicked. 
· For group services, especially where the number in the group is large, entering "Number required in Group" will prevent the user from adding more than that number to the group.  It will also prevent saving the record until that number has been added to the group.

Session Notes

If desired, users may attach notes to service sessions by clicking on the "Session Notes" tab.  To create a note, check the "Attach note to session" box.  Select the session start and end times, and type the note in the text box (up to 4000 characters).



The note can be printed if a paper copy is needed.  Once saved, session notes are displayed on the Notes tab of the client's record window.



Trip Log

When the service session involves client transport, the trip information can be captured on the "Trip Log" tab.  Check the "Service Included Client Transport" box, then enter the relevant trip information.  New items can be added to the Purpose, Destination, and Vehicle lists simply by typing them into the associated text box and then confirming the new entry in the resulting dialog.



Tangible Goods

When the service being rendered involves distribution of  actual goods, e.g., clothing, food, etc., the type and quantity can be captured for reporting purposes on the "Tangible Goods" tab.  Add the distribution by checking the "Service Included Tangible Goods" box.



Select the type and quantity of the item, then click the Add button.  Repeat the process for each type of item distributed.  To add a new type of item to the list, simply type the new entry and confirm adding it in the resulting dialog.


[bookmark: Referrals]
Referrals

Referrals made to clients so they can receive services from other agencies can be recorded by selecting "Referrals" from the Activities menu, or by clicking the Referrals  button on the toolbar.



Select the type of referral and date it was made.  The agency to which the client was referred may also be entered.  If multiple referrals of the same type were made on the same day, indicate how many.  The staff member(s) making the referral may also be selected.  Finally, select the client to which the referral was made and the intake during which it was received.  The intake is normally selected automatically based on the referral date.



If multiple referrals of different types are made to the same client, the user may check the "Retain client data between entries..." option.  When this is enabled, the user only needs to select the type, agency, and number to create additional referral records for the selected client.
[bookmark: Notes]
Notes

Routine notes can be recorded for any client by selecting "Notes" on the Activities menu or clicking the Notes button on the toolbar.  The user must select the client type and the specific client, enter the date and subject, and the actual note up to 2000 characters in length.



Client notes can be viewed and accessed via the Notes tab of the client record window.
[bookmark: Questionnaires]
Questionnaires

Once a survey has been created, questionnaire data for the survey is input by selecting "Questionnaires" from the Activities menu or clicking the Questionnaires button on the toolbar.  Select the survey corresponding to the questionnaire, and enter the date it was completed.  If the survey was defined as anonymous, the client and intake entries are disabled.  In this case it is advisable to enter an optional control number to ensure the same questionnaire is not entered repeatedly.  Alternatively, if entering multiple questionnaires corresponding to a specific event, such as a class, the control number will automatically be retained between entries if the "Repeat control number" option is checked; this feature allows survey results to be grouped by control number when summarized.



If the questionnaire is not anonymous, the client's name and associated intake must be selected.



[bookmark: Assessments]
Self-Sufficiency Assessments

Arizona Self-Sufficiency Matrix data can be captured by selecting "Self-Sufficiency Assessment" from the Activities menu.  All of the elements for the matrix are displayed in the resulting window.



User's must enter the date the assessment was completed by a staff member, as well as selecting the participant for which the assessment was accomplished.  When the ratings are entered, the Status column will reflect the corresponding level, and the Criterion column will display the standard that applies to that rating.



The compiled results of these assessments are available for a user-determined period via the "Self-Sufficiency Assessments" report.
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Information Release Permissions

Shelters may track what participant information they are authorized to release to specified agencies by selecting "Information Releases" from the Activities menu and entering the data in the resulting window.  Select the participant, release type, the period for which the release is valid, and the agencies which are allowed to receive the information.  If the release type is not already in the dropdown list, enter the new type and click OK on the resulting dialog to add it.



If the release agency is not listed, click the "Add" button below the list, enter the new agency, and click the OK button below the entry.



The new agency is permanently added to the list.  Agency names can also be changed by selecting them in the list and clicking the "Modify" button.



The "Information Release Permissions" report compiles all release information that is current for the user-specified date.
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Bed Assignments

Bed assignments for residential participants and children may be made or changed by selecting "Bed Assignments" from the Activities menu or clicking the Bed Assignments  button on the toolbar.  The resulting window will display two lists for the selected campus and date:  the left list shows the clients for whom a bed assignment has not been entered, while the right treeview displays participants in their assigned beds.




Initial Bed Assignments

To make an initial bed assignments for clients whose bed was not recorded on their basic intake record, first select the campus and the date of the assignment, which should be the same as the entry date of their residential intake.   Then drag-and-drop the unassigned clients into the appropriate bed on the right.  If the user accidentally "drops" a client on the wrong bed, simply drag the client to the correct one.  Once all assignments have been made, click the OK button to save them.



Users can first review when a client was assigned a particular bed by hovering the mouse over the assignment.



Changing Bed Assignments

Clients can be moved from their existing bed assignment to another room/bed.  It is important to select the correct date that the client is moved for the bed history to be accurately reflected.  In this case, after the correct date has been entered and the "Refresh Lists" button is clicked, just drag-and-drop the clients from their existing bed into their new assignment, and click OK to save the record(s).


[bookmark: Lesson6]
Lesson 6:  Additional Data Elements and Features

[bookmark: FindClients]Find & Search Clients

After client records have been created, they can be subsequently opened using either the Find or Search utilities.

Find Clients

Usually client records are located by selecting Find Client from the Edit menu, or clicking the Find Clients button on the toolbar.  The resulting window lists clients by type, i.e., Participants, Children, Abusers, and Community Members.  The clients' names and aliases are displayed, along with their dates-of-birth and return status.  If the "Current" option is selected, only clients who have current intake records or who exited in the last 30 days are displayed.  The "All" option will populate the lists with every client record that has ever been entered.  To open the client's basic record, double-click on the list item, or select it and click the "Select" button.  (When the list is long, rather than scroll to find the client's name, just begin typing it into the text box (last name first) and the list will show the closest match.)



For current clients only the user can also click the "Intake" button to go directly to the extended intake window.

Search Clients

In addition to finding clients where their name or alias is known, client records can be searched by their names, dates-of-birth, Social Security Numbers, shelter-assigned optional identifiers, and their intakes' entry or exit dates.  The search utility is accessed from the Search Clients option of the Edit menu or by clicking the Search Clients button on the toolbar.  Select the type of search and enter the search criteria.

	Search by Name
	
	

	
	
	

	
	
	

	Search by Exact Date-of-Birth
	
	

	
	
	





	Search by SSN (Exact or Partial)
	
	Search by Shelter-assigned Optional ID

	
	
	

	
	
	

	Search by Entry of Exit Date
	
	

	
	
	




Once the search criteria have been entered, click the Search button to return the results.



Double-click the desired list item, or select it and click "Open" to view the associated record.  If searching by intake entry/exit dates, the intake record will be displayed.  Searches by other criteria will open the individual client record.
[bookmark: SearchCalls]
Search Calls

Call/Walk-In records  can be searched by selecting “Search Calls” from the Edit menu or clicking the Search Calls toolbar button.



To search for calls,  enter the date range of the search, check the data items to be used for selection, select the response to be matched, and click “Search”.


Matching records will be listed and can be opened by selecting “Open” or double-clicking.


[bookmark: AbuserAlerts]
Abuser Alerts

In cases where a victim is sheltered and there is a potential problem with the abuser, an alert record can be created or viewed by selecting "Abuser Alerts" from the Tools menu or by clicking the Abuser Alert  button on the toolbar.



"Current" alerts will be displayed whenever the associated victim has a current intake record.  Click the "Enter Records" button to create a new alert, or select an item and click "Edit" (or double-click) to edit an existing alert record.



The Participant (victim) potentially threatened by the abuser must be selected.  Enter all other known information as well.

An image of the abuser can be inserted directly from a file by clicking the "Insert from file" button, or scanned in from a connected scanner by clicking the "Scan Image" button.  If more than one scanner is detected, the user is prompted to select which device to use.  Depending on the scanner, user can then select scanning options.



Normally the "Preview" button should be selected first so the image can be cropped as desired before clicking the "Scan" button, which will add the image to the record.




When all the information has been entered, save it to the database by clicking "OK".  

A paper copy of the alert information can be obtained by clicking "Print", either in the edit mode or when viewing the list with an item selected, e.g.:


[bookmark: Delinlquent]
Delinquent Items

Items requiring attention are displayed automatically for most user roles when the application is first started.  The same items can be displayed by selecting "Delinquent Items" from the Tools menu.



The status of the following items are checked:

· Intake records that do not have "Entry Data Complete" or "Exit Data Complete" within 3 days (default) of the entry or exit date. 
· Hotline calls indicating "Shelter Provided..." that have not been linked to an intake within 3 days (default) of the call date. 
· Crisis intakes exceeding 120 days where the exit page does not have the "Extended stay approved" checked. 
· Non-resident intakes that do not have an exit date but have not received any services for 90 days (default).

Note:  The default values can be changed by a SysAdmin user from the “Delinquent Settings” item on the Admin menu.

The records associated with the delinquent list can be retrieved by selecting an item and clicking the "Open" button or by double-clicking the desired item.
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Audit

ShelterBase employs several methods to prevent users from entering conflicting information or saving records that are missing information or contain inconsistent data.  However, it is still possible for users to create records that are missing data or have conflicting entries.  Entries that are potentially faulty can be found by selecting "Audit" from the Tools menu.  It is highly recommended to run an audit before submitting important reports to funders.



By default, relevant records from the previous year are checked.  The can be altered by changing the To/From dates.  Once the date range of interest is entered, clicking the "Audit" button will check for the following issues (in decreasing level of importance):

· Intake records where the intake type (crisis/non-resident/transitional) does not match the shelter type 
· Intake records where the intake type is Crisis/Non-Resident DV/Transitional and the victim type is not specified (this would prevent the intake from being included in the VOCA report) 
· Intakes linked to call records where the outcome is other than "Shelter Provided..." 
· Service records where the service date is outside the associated intake period 
· Referral records where the referral date is outside the associated intake period 
· Child intakes where the children's entry/exit date is outside the parent's intake period 
· Child intakes missing an exit date after the parent has exited 
· Child absences occurring outside the intake period 
· Intake records where the entry date precedes the linked hotline call date 
· Intake records for the same participants with overlapping entry/exit dates 
· Intake records marked as "Continuation" without a linked intake 
· Bed assignments outside associated intake periods 
· Intakes where Abuser Relationship is not specified when the intake type is Crisis/Non-Resident DV/Transitional 
· Intake records where the substance abuse status is not specified 
· Participant and child records where ethnicity is not specified 
· Intake records where marital status and citizenship are left "unknown" 

Note:  The last three issues may very well be cases where the data is unknown, but are included in the audit so administrators can check the integrity of data entry. 

When the audit routine completes, it will display the potentially erroneous records.



The user can select questionable items and click the "Open Record" button to display the corresponding record and correct any errors.
[bookmark: Narratives]
Report Narratives

Many funder reports require narrative responses in addition to data compiled for client records.  These include the ACJC Annual , DES DVSR Quarterly,  FVPSA Annual, ADHS Safe Home Quarterly, and the DES Intervention Performance Measures.  To preserve these report items and embed them in associated reports, select "Report Narratives" from the Tools menu.



The window initializes with a list of narrative items that have been entered in the previous 6 months.  To enter new items, click the "Enter Records" button.



Enter the date of the report and select the appropriate report and narrative item.  Important:  Most affected reports cover a specific period:  enter the first day of the report period in the date selection.

When the report and item selections are made, a description is displayed on their right.  Narrative items are limited to 2000 characters.



Click "OK" to save each item, and the window will clear the report item and narrative entries.  Continue by selecting additional report items and entering the appropriate data.



When complete, click the "Show Records" button to return to the list of narratives that have been entered.



Narrative items can be edited by double-clicking or via the “Edit” button.
[bookmark: Lesson7]
Lesson 7:  Administrative Functions

Users in the “SysAdmin” security role, i.e., database administrators, have several functions available via the Admin menu to manage data integrity and user logins.  These include:

· Management of database users:  adding, deleting, changing roles and passwords
· Merging of various user-augmented categories (list items)
· Merging of duplicated participants
· Executing SQL scripts to modify the database
· Permanently deleting or restoring records that have been flagged as deleted
· Modifying settings for delinquent items
· Modifying TANF eligibility criteria displayed as help text on intake records
· Backup and Restore the database
· Rebuild database indexes
· View or clear the server log

[bookmark: ManageUsers]ShelterBase User Accounts

Each database user should have their own log in credentials to access the program.  User accounts can be created, edited, or deleted by selecting "Manage Users" from the Admin menu:



Initially, only the default "sa" user is listed.  To add a new user, click the "New" button, which changes the window to data entry view.  Enter a unique log in name and an appropriate password.  Additionally, select one of the following security roles for the user:

· SysAdmin:  A database administrator can see and edit all data, as well as create/edit user log-ins.  Administrative tools such as backup/restore and delete/undelete records are only available to administrator log-ins. 
· Staff Data Users can see and edit all client and staff data, including potentially confidential staff information. 
· Client Data Users can see and edit all client data, but only basic staff information, e.g., name and title. 
· Limited Users can create basic client and intake records, but cannot view extended intake information.  Additionally, they can enter client activity data:  services, referrals, notes, questionnaires. 
· Hotline Users can only enter hotline/walk-in records. 
· Read Only Users can view all information in the database, but cannot enter or edit records (useful for personnel who need access to information but are not involved in data entry).



Once the user information is completed, click OK.



[bookmark: MergeCategories]User accounts for members who have left the organization should be deleted by an administrator by selecting the account from the list and clicking "Delete".  Administrators can also select a user and click "Edit" to change the user's password or role (but not the log in name).   If a temporary password is assigned by the administrator when creating an account, the user should subsequently change the password with a personal choice by selecting “Change Password” from the Tools menu.
Merge Categories

ShelterBase employs several dropdown lists that may be augmented by users, which fall into two categories:

1. Lists that contain items required for funder reporting, which are displayed at the top, followed by user-added items beneath an "--Other--" heading.  These include Abuser Relationships, Call Subjects, Ethnicity, Exit Destination, Exit Housing, Exit Reasons, Hotline Referral Agencies, Prior Residence, Reasons Shelter Denied, Referral Sources, and Referral Types. 
2. Lists that only contain user-created entries include Campuses, Information Release Types, Information Release Agencies, Law Enforcement Agencies, Languages, Locations Served, Purpose of Trip, Religion, Service Location, Topic (of staff training), Tribal Affiliations, Vehicles (for client transport).  Also, some user-created lists are based on items created during setup:  Programs, Shelters, Services Offered and Service Focuses.

A problem arises with user-augmented lists when duplicate, misspelled, and erroneious entries are added.  These entries will often show up in funder reports in an “Other” category.  The problematic additions can’t simply be deleted because they may be referenced in various records.  However, they can be “merged” with (correct) existing entries by selecting “Merge Categories” from the Admin menu.



When the window is initially loaded, the "Category" dropdown does not include all lists.  They can be added to the category list by checking the "Include" option.

When a category is selected in the dropdown list, it will display all user-created items in the left (Source) list and all items, including fixed entries, in the right (Target) list. 



In the above example, Native American has been added to the list, which duplicates the fixed "Native American/Eskimo" item used for many funder reports.  To correct this, select the extraneous item on the left and the correct item on the right, then click the “Merge” button.  The erroneous entry will be removed, and any records with that selection will be updated to the correct value.

There may be cases where similar items should be merged into a new, encompassing entry, especially when dropdown lists become excessively long.  To accomplish this, add the new category in the “New Item” box and click the “Add New Item to Lists” button.  Once the new item is added, merge all the related items into the new list item.
[bookmark: MergeParticipants]
Merge Duplicated Participants

Once a participant has been entered into the database, the same person should NOT be re-entered, for example, for a subsequent intake.  ShelterBase warns the user when attempting to save a participant record with the same DOB as other participants.  If the same participant is inadvertently re-entered, affected reports will treat the individual as a new, unique client, including all services provided.

Despite the warning, users have been know to make separate participant records for the same person followed by new intakes, services, etc.   To remedy this error, select "Merge Participants" from the Admin menu, which will open a window displaying all participant records with matching DOBs and the same first or last initial.



Participant records for suspected duplicates can be opened and compared.  If the record is indeed a duplicate, select the record that will be retained and click the “Merge” button. 



If the participant has children, those children must be merged (or added) before the participant records can be combined.  Select the child in the left list and the matching child in the right list, both of which should have the same DOB.  If the DOBs do not match, the user will be asked to confirm the operation before continuing.  Click the "Merge" button for the children to combine all related intake and service records.



If there is no matching child in the right-hand list, select the "<Add Child>" item and click the "Add" button.



Once all the children are added to the target list, the participant "Merge" button will be enabled.  Clicking it will result in a final warning.



Once the merge operation is completed, the window returns to the DOB list for additional operations.  The “merged” participant’s record will now reflect all the intakes, services, etc. that were recorded in the previously duplicated records.
[bookmark: Scripts]
SQL Scripts

Revisions to the database can be accomplished by running scripts written in Structured Query Language (SQL).  This is a potentially hazardous operation that can only be executed by admin users when an update is received from the developer.  The script will be enclosed in a file ending with a ".sql" extension, and should be temporarily saved to a convenient location.  The user should then select "Run Script" from the Admin menu.



Click the Browse button and navigate to and select the saved sql file, which will load the script into the window.



Once the script has loaded, click the "Run" button.  Depending on the complexity of the task, it may execute immediately or take several seconds, at the conclusion of which it will display the success status at the bottom of the window.



If the script execute successfully, close the Run Script window and delete the script file, which has no further use.  If an error occurs, DO NOT attempt to run it again; contact the author of the script.

[bookmark: DeletedRecords]
Deleted Records

In most cases, when a user "Deletes" a record it still exists in the database and can be recovered by an admin user.  Alternatively, admin users can permanently purge these records to reduce the size of the database and free up disk space.  Records that can be recovered include Abuser Alerts, Abuser Intakes, Abusers, Child Aliases, Child Intakes, Children, Community Members, (Staff) Credentials, Emergency Contacts, Grantors, Grants, Hotline Calls, Information Releases, Intakes, Interventions, Notes, Participant Aliases, Participants, Presentations, Questionnaires, Referrals, Report Narratives, Self-Sufficiency Assessments, Service Sessions, Staff Members, Staff Training Sessions, Surveys, and Volunteer Activities.

Admin users can permanently delete or restore records by selecting "Deleted Records" from the Admin menu.



When a Record Type is selected, corresponding "deleted" records are displayed in the right-hand list.  Also, record types that are related to the selected type are displayed in the left list.



To restore or permanently delete records, the user should check the appropriate item and click the "Restore" or "Delete" button.  



By default, all records related to the indicated item(s) are restored; this can be overridden by unchecking the "Restore Related Records" option.  For delete operations, all related records will also be purged; this operation cannot be undone.
[bookmark: Backup]
Backup/Restore Database

The importance of regularly backing up the database is highlighted by mishaps such as disk failure and malware.  Automated backup can be instituted by admin users by selecting "Backup/Restore" from the Admin menu.



ShelterBase can create two types of backup files.  The first method accomplishes a normal SQL Server backup operation that stores the backup file on the same hard drive as the original database, typically in a folder like "C:\Program Files\Microsoft SQL Server\MSSQL11.SQLEXPRESS2012\MSSQL\Backup".  In addition to being prone to the same hazards as the original database, this file is not particularly secure, i.e., it can be copied and easily restored on an unauthorized computer.

A second type of backup, referred to as a local backup, creates a compressed, encrypted copy of the database and stores it in a location designated by the user.  This type of backup cannot be restored without using the ShelterBase restore method.

Backup files will have will have names in the following format:  ShelterBaseBU-MMDDYY-n.bak, where MMDDYY indicate the date the operation.  The "n" digit is incremented for each backup made to the same folder on the same day.

Both types of backup operations can be automated by completing the "Automatic Backup Settings" entries.  For normal server backups, check the "On Server" option and enter the frequency.  In this case, a server backup will be accomplished the first time a user launches the program after the selected period.



Local backups are accomplished based on the settings of each admin user who automates the option, i.e., they are unique to the particular admin user on the client computer creating the backup.  The local option must be checked and the frequency of backups entered (in days).  In addition, the location must be selected using the "Browse" button, preferably to a folder NOT located on the same hard drive as the original database.  Once entered, clicking the "Save Backup Settings" button will persist the backup options.

Admin users can also manually backup the database at any time, either a server backup, a local file, or both.  If creating a local backup, checking the "Keep Copy on Server" will also leave a regular server backup in the default location.  Clicking the "Backup" button initiates the operation and the user is advised when it is successfully completed.

[bookmark: Restore]Restore Operations

Restoring the database from a backup file is initiated from the "Restore" tab.



When the database is restored from a backup, any information in the existing copy is overwritten, i.e., entries made after the backup was performed will be lost.  Before the restore operation is initiated it's advisable to first complete a manual backup.

The restore tab displays entries for restoring from a local (encrypted/compressed) backup by default.  Click the "Select" button to browse for and select the desired backup file.



Once the "Restore" button is clicked the current database is overwritten from the backup's contents, which may take several seconds.  When complete, the user is notified if the operation is successfully completed.  If the operation fails the user will be directed to check the server log.

Select the "Restore from server file" option to effect a restore operation from that type of backup file.  The window will display a dropdown of all the backup files in the server's default backup folder.



The server backup folder can eventually require a great deal of disk space, so it can be a good practice to (carefully) delete old copies.  The contents of the folder can be viewed on the "Server Backup Files" tab by clicking the "Get Server Backup Files" button.



Check any unneeded backups and click the "Delete" button to remove them from the backup folder.  This operation may fail depending on the user's access privileges to the backup folder.
[bookmark: Lesson8]
Lesson 8:  Reporting

Reports produced by ShelterBase can be divided into the following groups: 

· General Reports that compile data for a specified period or date.  These are further subdivided to cover:
1. Participants and Children 
2. Abusers 
3. Funders/Grantors 
4. Shelter Management/Analysis 
5. Client Services 
6. Staff Information
· Survey Results that summarize the selected survey(s)
· Generic Reports summarize client and service data for user selected shelters, programs, services, and staff
· Client Reports selected from client, intake, and service windows showing details for a specific client
· Administrative Reports for shelter and database administration

The various reports filter, sort, group, and compile data based on a number of criteria which should be understood before comparing results among reports. 

Additional considerations that apply to report computations:

· Age:  Nearly all reports that indicate the client's age compute the figure based on the client's entry date, i.e., the age of the client when service began.
· Bednights for residential clients are based on nights in shelter during the report period, or the total number of bednights received.  In cases where a resident client entered and exited shelter on the same day, one (1) bednight is computed.


[bookmark: GeneralReports]General Reports

Most reports generated by ShelterBase are accessed from the "General Reports" tab in the Reports window, which can be opened by selecting "Reports" from the Tools menu or clicking the Reports button on the toolbar.   Available reports are organized in groups: Abusers, Participants/Children, Funders/Grantors, Shelter Management/Analysis, Client Services, and Staff Information.  Data for these reports is often filtered by various criteria.

General reports use a number of elements to filter, group, and sort the reported data.  As a result, attempts to compare information between reports, especially those generated for grant reporting, can lead to confusion if the selection criteria are not understood.  These criteria include Intake Type,  Shelter Type,  Client Type, Victimization, and Program(s).


Many of the reports that are available may not apply to most users, so the reports list can be modified to display only those of interest by clicking the "Add/Remove" button.  In the resulting list, check reports of interest and uncheck those that should be removed. 



When a report is selected in the left list, date selection components and a description are displayed on the right.  Date entry varies depending on whether the report is primarily annual, quarterly, monthly, for a specified period, or for a specific date.  The user may also check the "Manual date selection" option and enter specific dates for Annual/Quarterly/Monthly reports.  Using manually entered dates for reports that are designed for specific timeframes may produce misleading report data.

	Annual
	
	Quarterly
	
	Monthly

	
	
	
	
	

	Specified Period
	
	Specific Date
	
	Manual Date Selection

	
	
	
	
	




Some reports allow application of additional "filters" to be applied to the data being compiled.  When a filterable report is selected, the "Additional Filters" link is visible:



Clicking the link will open a window displaying the various filters that can be applied to the report.  To apply additional filters, check the boxes for the desired filter type, then check all record types in the list that should be included in the report.


Click the OK button to return to the report window.
Once a report has been selected the date(s) of interest entered, and optional filters applied, click the "Preview" button to display the results.  From the resulting window, the report can be printed or exported to PDF, Excel, or Word format files.


[bookmark: SurveyResults]Survey Results

Composite results of questionnaires entered for surveys are obtained from the "Survey Results" tab of the reports window.



Responses to the selected survey(s) are compiled for corresponding questionnaires.  Results displayed for each question included the number of responses, the average response, number of responses greater than the median, percentage of responses greater than the median, and the number of responses for each level of the Likert scale.

If desired, results for more than one survey can be compiled into a single report.  For example, different but similar surveys may be completed by resident and non-resident clients.  If both are checked in the surveys list, responses to questions from both surveys will be compiled.  Where the same question is used for both surveys, the results will be combined.

The report can display all corresponding questionnaires, or only those from a specified period.  For results from questionnaires that are not submitted anonymously, the results can further be restricted to a specific intake type.

Responses to narrative questions are only included in the report if the "Include Narratives" option is checked.

There may be instances where multiple questionnaires have the same control number, such as those completed for different sessions of the same class.  To isolate those sessions separately in the report, check the "Group by Control Number" to separately compile the results.
[bookmark: GenericReport]
Generic Report

Data for a variety of shelter operations can be compiled in a report accessed from the "Generic" tab of the reports window.



This report is particularly useful for grant writers as well as compiling information for grant reports that are not produced elsewhere.

Data is compiled for records within the selected date period, and results are grouped for each category selected from the lists on the right.

· Shelters: Displays numbers of participants and children sheltered and their total lengths-of-stay, grouped by intake type, with subtotals for each shelter and a grand total for all shelters. 
· Programs: Summarizes the number of service sessions administered by each selected program, along with client hours and staff hours. 
· Service Types: Summarizes the number of session, client hours, and staff hours for each targeted service, with a grand total for all services. 
· Staff: For each staff member targeted by the grant, displays a summary of the number of service sessions, hours of service, and client hours, with a total for all grant related staff.

A demographics page for each target type summarizes the following information for participants, children, and abusers: Unique client count, ethnicity, tribal affiliation, service area locations, counties, reservations, sex, age, and income level. 

If desired, the user has the option of displaying the details of the selected data, i.e., the specific clients and their demographic data used to generate the summary information. Note that this can make the report very long, especially if it covers an extended time period.

[bookmark: CompareSurveys]Compare Entry/Exit Surveys

Results of surveys used to measure client progress can be compared using the "Compare Entry/Exit Surveys" tab of the reports window.



Note that this cannot be used for "anonymous" surveys.  The resulting report will include questionnaires completed by clients with an exit date between the user-selected dates.


[bookmark: ClientReports]
Client Reports

The following reports for individuals are accessed from specific windows in the program:

Client Notes:  From the Notes tab of the client data window, the user can print any or all notes entered for that client. The report can be restricted to general notes or those entered for a service session. The user can further restrict the report to notes entered during a specified period. The resulting report shows the date, subject, and note entered, as well as the user who entered and/or edited the note. 

Services & Referrals:  Selected from the Admin tab of the participant's intake window, the resulting report shows all services and referrals associated with the intake. The services are divided between individual and group service types, and further grouped by the week of the intake during which they were provided. For each service, the report displays the associated program, service date, service type, focus, session time, and staff member(s). For each referral there is a column for the date, number of referrals, agency, and referring staff. 

Surveys:  This report is available from the Admin tab of the participant's intake window, and is available if the participant has completed any non-anonymous surveys associated with the intake. It is used to display results of all questionnaires submitted by the participant for a specific survey. Each survey question is shown, with a column for the date and response of up to 10 questionnaires for that survey.

Exit Report:  Available on the Admin tab of the participant's intake window after an exit date has been entered, the report displays entry and exit dates, entry/exit income, children sheltered, exit reason and exit destination. It also displays a summary of services and referrals provided, including number of sessions and hours for each service type, and the number and type of referrals provided.


[bookmark: AdminReports]Administrative Reports

Additional reports available for shelter administration include:

Abuser Alert:  Available from the Abuser Alerts window, the report displays all information entered for the selected abuser, i.e., name, address, description, and vehicle information. 

Audit:  Prints the results of a records audit from the Audit window, grouped by discrepancy type.  Information is essentially identical to the information displayed in the window after the audit has been run.
[bookmark: GrantReports]
Grant Report Considerations/Idiosyncrasies

Most of the questions and problems with grant reports are due to misunderstandings of the specific reporting requirements and how data for various sections are aggregated.  Also, some of the reports require additional steps when setting up the underlying grant record as well as associating the grant with related surveys.  The following information should help users understand how to set up ShelterBase to accurately compile data for these reports, as well has how some of the items are computed.



Arizona Criminal Justice Commission (ACJC)
Annual Performance Report

ACJC grant record must be entered and reflect the shelters in the organization to which the grant applies.

Includes clients with an intake during the report period that indicates one or more types of victimization.  Also includes callers served via hotline where the call subject is a victim type.

Most services are counted as number of sessions, i.e., contacts, delivered where the service is mapped to an ACJC service type.  ACJC counts the act of making referrals as a service, so referral records are internally mapped to that service type.  Hotline "crisis" calls are reported as Crisis Counseling via Hotline, and Info/Referral calls are counted as the Referral service type. Units of service for shelter are computed as the number of bednights for participants and children sheltered.



Arizona Department of Economic Security (DES)
Domestic Violence Services Report (DVSR)

Grant Setup: 

1. The DVSR information is calculated based on the associated DES grant; if a current grant is not entered for the specified report period (common problem during the first FY quarter), the quantitative results will be blanks.  
2. The DES grant record must reflect which shelters within the organization are funded by the grant—usually, but not always, it’s all of them.
3. The surveys used to measure the Core Outcomes in Item 19 must be linked to the grant.  This can be done by editing the grant record in the Grants & Grantors window of in the Surveys window.

Clients data includes all participants, children, community members, and hotline callers.  Participants and children are included if they have an intake of any type except “Resident Other” during the report period.

Counties and Reservations served are based on County and Reservation selections of the “Client Data” tab of the intake record.

Program Staff are counted based on those staff whose “Date Left”  entry, if any, is after the beginning of the report period.  Emergency Shelter Beds includes all beds in the grant-related crisis shelters that are current during the report period.  Transitional shelter “rooms” are counted as transitional housing units.  Motel and private residence beds count the number of beds assigned to participants and children during the report period where the intake’s associated shelter type is a motel or private residence.

Services in Items 10 (new clients) and 11 (carryover clients) counts the staff hours provided for services that have been “mapped” to DES service types.  The residential services section includes intake types of Crisis, Homeless, and Transitional, while the mobile advocacy and community based services section includes intake types of Non-Resident DV and Non-Resident Other. (Exception:  The DVSR 2 report, which is only used by Mt. Graham Safe House, counts services to transitional intakes in the non-resident function as their DES grant does not pay for the transitional units.)   Clients with an intake entry date during the report period are counted in Item 10 (new), all others are counted in Item 11.  Community clients, who do not have an intake date, are always counted in Item 11 and are NOT included in the demographic summary of Item 13.

Unit/Hours of Service allocation between New/Carryover and Women/Children/Men can be complicated by group services.  When this occurs, the total staff hours for the session are split equally among the clients in the appropriate category.
For survey data to be included in Item 19, Core Outcomes, surveys must be linked to the grant and include questions for:
· Increased knowledge of services available
· Knowledge of how to plan for continued safety
· Personal safety has improved

To assist with DES audits, two unofficial funder reports exist for “DVSR Details”.  They show all the individual clients included in each category of Items 10 and 11.  The “anonymous” version substitutes unique ID numbers for actual client names. 



Arizona Foundation for Legal Services and Education (AFLSE)
Domestic Violence Legal Assistance Program (DVLAP)

This report is presented as a spreadsheet and should be saved in Excel format.  When opened in Excel the results can be copy/pasted into the spreadsheet provided by AFLSE.  Participants that received services that have been mapped to the lay legal service types are compiled into a unique count for each category.  Mapped services should only represent civil legal services, not criminal services.



Family Violence Prevention Services Act (FVPSA)
 Program Performance Report

Annual report includes all participants, children, and community clients served during the report period where their records indicate victimization.  Units of service for services mapped to FVPSA categories are for each session/contact.

The FVPSA grant may be awarded by state (ADHS) or tribal (e.g., Navajo Nation) agencies.




Arizona Department of Health Services (ADHS)
Safe Home Quarterly Statistical Report

This report summarizes the same FVPSA data for the specified quarter.  In addition, it includes two narrative responses for reporting significant accomplishments and program barriers which are identical to the DVSR narrative items.



Arizona Department of Public Safety (DPS)
Victims of Crime Act (VOCA)

VOCA grant reporting is potentially problematic due to the number of ways the funding is requested and awarded.  Also, it’s not uncommon for the same organization to have more than one VOCA grant.  The VOCA report only includes clients where victimization is indicated on their intake record or, for community records, on their member record.

Each VOCA grant may be associated with any or all of three options:

1. The grant may be linked to one or more shelters within the organization.  In this case, the VOCA report will include all victims with an intake in the grant-related shelter(s) during the report period.
2. One or more programs can be linked to the intake, in which case the report will include all victims receiving services from the selected program(s) during the report period.
3. Many VOCA grants are directed to a specific staff position.  In this case, all victims receiving services from the designated staff will be included in the report.

In addition to linking VOCA grants to specific shelters/programs/staff, a factor to prorate results can also be entered.  For example, if the VOCA grant ostensibly funds 30% of a program and that figure is used for the grant, the report will include a column that computes 30% of the total for each item.

Community clients do not have an intake record and are therefore not linked to a shelter.  To ensure services rendered to these victims are included, organizations should link a program to the grant as well as whatever shelter is funded by the contract.  When a VOCA grant is linked to both shelters and programs, the duplicated victims served by both are resolved to produce a unique count.

The VOCA report produced by ShelterBase groups data by contract when there are multiple VOCA grants.  Organizations use the results to input the aggregated results on the DPS web site.

Reminder:  All victims are counted as “New” the first quarter of the grant period.

[bookmark: ReportingIssues]Common Reporting Issues

· Organizations often fail to enter new grants at the beginning of a fiscal year, which results in data not being compiled for DES, VOCA, and ACJC grant reports.
· When new services are added to the program, they must be “mapped” to all relevant grantor service types to be reflected on the associated reports.
· Users new to ShelterBase will often compare reports with differing selection criteria and question why the results differ.
[bookmark: Lesson9]
Lesson 9:  Troubleshooting & Common Support Requests

[bookmark: RemoteAccess]Remote Access

Many support situations are too difficult to resolve without some type of remote access to the users having a problem.  Connecting to the client or server computer can usually be accomplished using:

· Teamviewer (www.teamviewer.com) is a popular application for remote support.  It must be installed on both the user’s computer as well as the support machine.  The user must provide the support person with their unique Teamview ID followed by their password, after which the problem machine can be remotely controlled.  Another useful feature is direct file transfer between the connected computers, especially when retrieving a backup copy of the user’s data for additional study.  When installing Teamviewer ensure the option for “Personal Non-Commercial Use” is selected.
· Microsoft Remote Desktop is useful, especially for connecting to dedicated servers running a version of MS Windows Server.  This usually requires contract or organiic IT personnel to set up a user account (with administrative priviledge) on the target machine.
· Other services, such as GoToAssist and JoinMe, may be used when working with IT personnel. 


[bookmark: ConnectionIssues]Connection Issues

The 3-tier architecture of ShelterBase, while improving security and performance, also allows more areas for temporary failure, most of which are easily resolved.



ShelterBase Server or SQL Server (Windows services) not started

These two problems present a little differently but are essentially due to the same issue, i.e., a Windows service that is set to start automatically when Windows launches did not start for some reason.  This is more common when a user’s desktop also hosts the ShelterBase server components, especially when the machine is under-powered.

If a connection to ShelterBase Server cannot be established the user will get this message:



After clicking “OK”, the user will then be advised that the connection settings do not work and offered a chance to change them.



If the saved settings were previously working, it’s usually best to click “Cancel” and fix the underlying issue.  If ShelterBase Server is on the same computer as the client with a connection problem, it probably didn’t start automatically when Windows booted.  If this is the case, a user can:

· Reboot the server computer; if the ShelterBase service starts the problem will be resolved.
· Open Windows Services by clicking the Start button, then typing “services.msc” <enter>.  In the resulting window, scroll to ShelterBase Server in the list, right-click, and select “Start”. 
· Alternatively on the server open the ShelterBase Configuration tool; in the resulting window click the “Start ShelterBase Server” button.

If ShelterBase Server is on another (network) computer:

· The server computer may be shut down or in sleep/hibernate mode. 
· The server name may have been changed. 
· If the network client uses the server's IP address rather than network name to find the server, the IP address may have changed.  When the IP address is used, the server should be configured to use a static IP address. 
· The server's firewall settings may not be configured to allow ShelterBase Server to access the network; refer to the Setup section on how to configure the firewall.

When SQL Server does not start automatically, the user will get a login window but will receive a message after attempting login:



This indicates that the SQL Server instance that hosts ShelterBase did not start automatically when MS Windows launched.  The user may reboot the server and see if this corrects the problem.  Alternatively, on the server open the Services window (services.msc) and scroll to the SQL Server instance that hosts ShelterBase.



Right-click on the entry and select Start.  If the instance fails to start, consult Microsoft documentation for additional trouble-shooting options.



[bookmark: DomainAuthentication]Domain Controller Authentication

For domain networks only (usually managed by contract or internal IT personnel) the server can be set to use domain controller authentication when users log in.  If this is the case, when setting up each client on the network that option must also be selected.




[bookmark: ServerTimeout]Server Timeout

On busy, over-tasked, and/or under-powered servers it’s not uncommon for users have problems retrieving or creating data records.  For example, some reports require more intensive processing on the server before returning the results to the client.  The server will essentially just ignore the task and the client will eventually generate a timeout message.

This problem has usually been observed when a server computer is running multiple “virtual machines”.  In this situation each virtual machine has a specified allocation of the computer’s total resources.  It is usually best to allow a minimum of 4 GB of memory to the machine running SQL Server.  This issue requires the IT manager’s involvement.



[bookmark: ApplicationFailure]Application Cannot Be Started

In some cases the ShelterBase application files have become corrupted or are otherwise incompatible with the .NET framework.  When this happens the user will get the message:

“Application cannot be started.  Contact the application vendor.”

Determining the exact problem can be time-consuming, so it is typically easier to uninstall ShelterBase and download/re-install the program.  If the problem persists after reinstallation more thorough measures must be taken.  

First uninstall the program again.  Then use Windows File Explorer and delete the “2.0” folder at:  “C:\Users\<user name>\AppData\Local\Apps\2.0”

Once the folder is deleted, download/install the program again.



[bookmark: OtherIssues]Other Common Support Problems & Requests

Many users will call for tasks which they can accomplish on their own, unbeknownst to them.  These include:

· Create a log in for a new user
· Perform a client software installation on a new computer
· Change passwords
· Create new surveys
· Add new services & focuses
· Enter report narrative items



[bookmark: MoveDB]
Move database to new SQL Server Instance

Sometimes the database must be moved, either to a new instance of SQL Server on the same computer, or to another computer entirely.  There are generally two ways to do this, either by restoring the data to the new instance from the most recent backup, or by using SQL Server Management Studio (SSMS) to “attach” copies of the existing data and log files to the new instance.  Using either method will restore the data, but additional steps will be necessary afterward to re-create user logins.


Restoring from a backup

Once the new SQL Server installation is complete, also install ShelterBase Server and the Server Configuration Tool if this is on a different computer.  Use the Configuration Tool to change/set the SQL Server instance to be used.  Then use the Create ShelterBase item from the File menu to create a new, empty database.

Once the new database is created, connect to it from a client and use the Restore option from the Admin menu to overwrite the empty database with the backup copy.


Restoring using SSMS

The first step is to copy two files from the original SQL Server instance, ShelterBase.mdf and ShelterBase.ldf (sometimes may be ShelterBase_log.ldf).  They will be in a folder similar to: 

C:\Program Files\Microsoft SQL Server\MSSQL13.SQLEXPRESS2016\MSSQL\DATA

Copy/paste these files to the equivalent folder of the new SQL Server instance.  Launch SSMS, and in the Object Explorer window right-click on the Databases folder and select  “Attach…” from the context menu.



Click on the “Add” button and locate the ShelterBase.mdf file in the resulting file browser window.  The data and log files will then be displayed in the two listviews.  Click OK and the database will be added to the new SQL Server instance.


Re-Create User Logins

Moving the database to a new instance has one remaining issue:  the original user logins will not exist on the new instance.  Former sysadmin users will have no login and will not even be listed in the “Manage Users” window, while other users’ login names will appear but will not have a current login.  




The only current user is the default “sa” account established when the new instance was created.  The sa user will need to create new logins for the former sysadmin users.   Other users, e.g., ClientDataUsers, can be edited with a new password entered to re-establish their logins.
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